Siebel Email Marketing
On Demand Online Help

Release 1.2
March 2008
Contents

Chapter 1: Administering Email Marketing On Demand
Email Marketing On Demand Quick Start 5
Supported Platforms and Languages 6
Installing and Configuring the Email Marketing On Demand Editor 6
Using Email Marketing On Demand 6
Managing Email Marketing Users 7
   Adding a User to Email Marketing On Demand 7
   Editing a User in Email Marketing On Demand 8
   Deleting a User in Email Marketing On Demand 8
Managing Email Marketing Libraries 9
Creating Email Marketing Templates 10
Viewing Email Marketing Library Usage 11
Viewing Outbound Email Usage 11

Chapter 2: Using Email Marketing On Demand
Creating Marketing Emails 13
Creating Campaigns 14
Selecting Campaign Recipients 16
Creating Email Content 17
Designing the Email Message Header 17
Designing the Email Message Body 19
   Using the Email Marketing Editor 20
   Adding Response Hyperlinks 27
   Using Conditional Content in Email Marketing 31
   Inserting Images in Email Content 34
   Associating Documents with an Email 35
Creating a Text Email 36
   Previewing Email Message Content 37
   Previewing an Email Message 38
   Sending a Test Email Message 38
Scheduling the Email Campaign 38
Chapter 3: Measuring Campaign Effectiveness

Recording Responses to Campaigns 41
Reviewing Campaign Responses 42
  Managing Bounced Emails 43
  Tracking Click-Through Responses 43
Email Campaign Responses and Statistics 44
  Analyzing Mailing Delivery Status 44
Generating Delivery Statistics 45
Generating Response Analyses 45

Appendix A: Best Practices for Email Marketing On Demand
Email Marketing Best Practices 47

Appendix B: Basics of Email Campaign Development
About Email Campaign Development 51
Where to Begin 51
  Determining the Goals of Your Campaign 52
  Determining Your Target Market 52
  Determining Your Call to Action 52
  Developing Your Privacy Policy and Anti-Spam Policies 53
Choosing Your List 53
Importance of Permission 53
Deciding on Your Message Format 54
Determine Your Content 54
Determining Who Will Manage Your Creative 54
Deciding How Many Mailings Will Be in Your Campaign? 55
Implementing Response Tracking 55
Organizing Internal Resources for Handling Responses 55
Planning for Unsubscribed and Failed Messages 55
Developing a Message Testing Plan 56

Appendix C: Troubleshooting Email Marketing On Demand
Troubleshooting in Email Marketing On Demand 57

Index
This chapter describes how to configure Email Marketing On Demand settings. It includes the following topics:

- Email Marketing On Demand Quick Start on page 5
- Supported Platforms and Languages on page 6
- Installing and Configuring the Email Marketing On Demand Editor on page 6
- Using Email Marketing On Demand on page 6
- Managing Email Marketing Users on page 7
- Managing Email Marketing Libraries on page 9
- Creating Email Marketing Templates on page 10
- Viewing Email Marketing Library Usage on page 11
- Viewing Outbound Email Usage on page 11

### Email Marketing On Demand Quick Start

The steps required to create, test and send a mailing are outlined in Table 1.

Table 1. Quick start steps

<table>
<thead>
<tr>
<th>Step</th>
<th>Relevant Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a new Campaign record in Siebel CRM On Demand</td>
</tr>
<tr>
<td></td>
<td>“Creating Campaigns” on page 14</td>
</tr>
<tr>
<td>2</td>
<td>Select the contacts who will receive the email and associate them with the newly created Campaign</td>
</tr>
<tr>
<td></td>
<td>“Selecting Campaign Recipients” on page 16</td>
</tr>
<tr>
<td>3</td>
<td>Specify the format and content of your email header.</td>
</tr>
<tr>
<td></td>
<td>“Designing the Email Message Header” on page 17</td>
</tr>
<tr>
<td>4</td>
<td>Create or upload the body of your email message</td>
</tr>
<tr>
<td></td>
<td>“Designing the Email Message Body” on page 19</td>
</tr>
<tr>
<td>5</td>
<td>Preview your email to see how it will appear to your recipients</td>
</tr>
<tr>
<td></td>
<td>“Previewing Email Message Content” on page 37</td>
</tr>
<tr>
<td>6</td>
<td>Schedule and send the mailing to your recipients</td>
</tr>
<tr>
<td></td>
<td>“Scheduling the Email Campaign” on page 38</td>
</tr>
</tbody>
</table>
Supported Platforms and Languages

Email Marketing On Demand runs on Microsoft® Internet Explorer version 6.0 or later.

The languages currently supported are:

- German
- English-British
- English-American
- Spanish
- French
- Italian
- Portuguese

This applies to the Email Marketing On Demand editor specific content, menus, toolbars and dialogs, as well as the Email Marketing Administration screens.

Installing and Configuring the Email Marketing On Demand Editor

The Email Marketing On Demand editor is based on a third party tool called eWebEdit Pro, from Ektron, and uses an ActiveX control. Users must install the ActiveX control when prompted, and must set the appropriate permissions for ActiveX in Internet Explorer.

In the Zone security, for the zone where you are running the editor, do the following:

- Set Download signed ActiveX controls to either Enable or Prompt.
- Set Run ActiveX controls and plug-ins to Enable (the Prompt setting would inundate you with dialogs).
- Set Script ActiveX controls marked safe for scripting to Enable.

**NOTE:** If you do not have the editor installed, you may see a yellow bar at the top of the window, giving you the option to install it.

Using Email Marketing On Demand

You can use Oracle’s Siebel Email Marketing On Demand to design and distribute a personalized email to targeted recipients of a campaign.

Email Marketing On Demand has two types of users: email administrators and email authors.

Email administrators perform the following tasks:

- “Managing Email Marketing Users” on page 7
- “Managing Email Marketing Libraries” on page 9
Email authors perform the following tasks:

- "Creating Marketing Emails" on page 13
- "Viewing Outbound Email Usage" on page 11

Managing Email Marketing Users

When you initially subscribe to the Email Marketing On Demand service, a single Email Marketing administrator is created for your company. This administrator can then add more users and can designate these users as administrators or authors.

Before a user can be added to Email Marketing On Demand, they must:

- already exist as a user within Siebel CRM On Demand
- have the required privileges associated with their Siebel CRM On Demand role.

Email Marketing On Demand privileges can be added to any user role.

There are three Siebel CRM On Demand privileges associated with Email Marketing On Demand, depending on how you use the application. Table 2 describes these privileges.

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Marketing: Administer Email Marketing</td>
<td>Enables access to Manage Email Marketing Campaigns, view Usage Statistics, and manage Users.</td>
</tr>
<tr>
<td>Email Marketing: Author Email Marketing</td>
<td>Enables the Setup Email button on the campaign header detail screen.</td>
</tr>
<tr>
<td>Email Marketing: Manage Email Marketing Access</td>
<td>Enables a link to Email Marketing Administration on the Siebel CRM On Demand Administration page.</td>
</tr>
</tbody>
</table>

Adding a User to Email Marketing On Demand

You must add employees as Email Marketing On Demand users before they can log into Email Marketing.

To add users to Email Marketing On Demand

1. Navigate to Admin > Email Marketing > User Administration.
2. In the Users list, click New to add a new record.
3 Complete the fields, as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>Enter the user’s first name (required).</td>
</tr>
<tr>
<td>Last Name</td>
<td>Enter the user’s last name (required).</td>
</tr>
<tr>
<td>Work Phone#</td>
<td>Enter the user’s work phone number.</td>
</tr>
<tr>
<td>User ID</td>
<td>Enter the user’s User Sign In ID from Siebel CRM On Demand (required).</td>
</tr>
<tr>
<td>Email Administrator?</td>
<td>Select this check box to make this user an Email Marketing On Demand administrator.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Select the user’s time zone (required).</td>
</tr>
</tbody>
</table>

**NOTE:** The User ID you enter here must be identical to the User Sign In ID specified in Siebel CRM On Demand User Management. To locate the User Sign In ID, navigate to Admin > User Management & Access Controls > User Management and then, in the User List, click the user’s last name hyperlink to open the user detail record.

4 When you are finished completing the fields, either click Save to save the record or click Save & New User to save the record and add another new user immediately.

**Editing a User in Email Marketing On Demand**

You can edit the record of an existing user.

*To edit a user record*

1 Navigate to Admin > Email Marketing > User Administration.
2 In the Users list, click the name of the user.
3 In the user details form, make necessary changes and click Save.

**NOTE:** The User ID and time zone specified here must be identical to the User Sign In ID and time zone specified in Siebel CRM On Demand User Management.

**Deleting a User in Email Marketing On Demand**

You can delete an Email Marketing On Demand user.
To delete a user record
1. Navigate to Admin > Email Marketing > User Administration.
2. In the Users list, click the name of the user.
3. In the user details form, click Delete.

Managing Email Marketing Libraries

An Email Marketing library can include:

- **Documents.** Documents such as text files, Microsoft Word files, PDF files, and other types of files. When authors create emails, they can include links to these documents by clicking the New Hyperlink icon in the HTML editor.

- **Email Templates.** HTML documents that Email Marketing authors can load into the editor and use as templates for their marketing emails. When authors create emails, they can load a template by clicking the Open icon in the HTML editor, and then use the editor to modify the template as necessary.

- **Images.** Graphics in JPG or GIF format that Email Marketing authors can include in their marketing emails. When authors create emails, they can include these graphics by clicking the Picture icon in the HTML editor.

**NOTE:** Before loading documents into a library, you must create them using the appropriate application. Before loading images into a library, you must create them using any graphics program and save them in JPG or GIF format. Before loading email templates into a library, you must create them, as described in “Creating Email Marketing Templates” on page 10.

You can also view and delete files in libraries.

**NOTE:** The Search Library page automatically performs a wildcard search; you do not need to use an asterisk (*).

To add files to the Email Marketing library
1. In the Email Marketing Administration page, click Hosting Library.
2. In the Hosting Library list, from the drop-down list, choose Documents, Images, or Email Templates.
3. Click New.
4 In the Library Edit page, complete the fields, as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Click the Browse button and choose a file on your computer that you want to add to the library. [\textbf{NOTE:} Individual files that you upload to the library can be no larger than 10 MB each.]</td>
</tr>
<tr>
<td>Name</td>
<td>Enter the name for this file that is displayed to authors of marketing emails.</td>
</tr>
<tr>
<td>Folder</td>
<td>Enter the name of the folder where this file will be stored. If this folder does not exist, the system creates it. If it does exist, the system uses the existing folder.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of file that you are adding: a document, image, or email template.</td>
</tr>
</tbody>
</table>

5 Click Save to save this entry and return to the Hosting Library page, or click Save and New to save this entry and add another new entry.

You can delete a file from the Email Marketing library.

**To delete a file from the Email Marketing library**

1 In the Email Marketing Administration page, click Hosting Library.

2 In the Hosting Library list, from the drop-down list, choose Documents, Images, or Email Templates.

3 Click the Del hyperlink in the file’s record.

You can view a file in the Email Marketing library.

**To view a file in the Email Marketing library**

1 In the Email Marketing Administration page, click Hosting Library.

2 In the Hosting Library list, from the drop-down list, choose Documents, Images, or Email Templates.

3 Click the View hyperlink in the file’s record.

**Creating Email Marketing Templates**

If you commonly use information such as your company logo, your company address, and boilerplate text, in marketing emails, you should create templates that include this information. Authors can then save time by opening these templates and using them as a starting point for marketing emails, rather than entering all the standard elements manually every time they create a new email.
Your template can be a basic text message or a stylized HTML message.

There are two ways to create Email Marketing templates:

- You can create a document that will serve as an email template using any HTML tool or text editor. After creating the source document, you upload it to the Email Marketing On Demand library, where authors can access it. For more information, see “Managing Email Marketing Libraries” on page 9.

- You can create the document that will serve as the email template using the Email Marketing HTML editor in the same way that authors create marketing emails; see “Creating Marketing Emails” on page 13. The email content is automatically saved in the library as a reusable template. Its name in the library is the name of the campaign from which it was created.

For example, if you have a monthly Email Marketing campaign, the author may create a campaign named March 2008, and the email for that campaign is saved in the library with the name March 2008. Then, when the author creates the April 2008 campaign, the author can open March 2008 as a template and modify it to create the marketing email for April.

### Viewing Email Marketing Library Usage

Email size within Email Marketing On Demand is based upon the size of the HTML code, which includes HTML references to any images, but not the images themselves. Graphics do not add to the size of the message, because graphic images are referenced from the Image Library and not attached to the email.

The host of your application specifies how much storage you are allocated for storing libraries on their server. You can view the total amount available and the amount used, through the Email Marketing Administration page.

**NOTE:** The default value provided is 500 MB; however additional storage can be licensed. The maximum size for any individual file you upload to the library is 10 MB. Contact your Siebel CRM On Demand Sales Representative for more information.

#### To view library usage

1. In the Email Marketing Administration page, click Library Usage.

   The Library Usage Report page appears, listing the size limit and total size you are now using. It also breaks down the total size by listing the library image size, document library size, and email template size you are now using.

2. Click Back to Email Marketing Administration to return to the main administration page.

### Viewing Outbound Email Usage

You can view the total number of emails you have sent through Email Marketing during past periods.
**To view outbound email usage**

1. In the Email Marketing Administration page, click Outbound Email Usage.
2. Specify the start date for the report:
   a. Click the Calendar icon next to the Start Date box.
   b. In the Calendar dialog box, select the date and time.
   c. Click Close.
3. Specify the end date for the report:
   a. Click the Calendar icon next to the End Date box.
   b. In the Calendar dialog box, select the date and time.
   c. Click Close.
4. Click Submit.

The Outbound Email Usage list shows how many emails were sent for each campaign during the period you specified. Some fields are described in the table that follows.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Because this is the real-time status for the email campaign, the status shown here may differ from the campaign detail page.</td>
</tr>
<tr>
<td>Emails Sent</td>
<td>The number of messages that have been sent.</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>The actual number of messages sent is affected by the number of bounced messages. For example, if you sent a mailing to 1000 recipients and 50 messages bounced, then the total number of messages sent was 950.</td>
</tr>
<tr>
<td>Total Emails Sent</td>
<td>The total number of sent messages for the selected time period.</td>
</tr>
</tbody>
</table>
This chapter describes how to design, create and send out your email marketing campaign. It includes the following topics:

- Creating Marketing Emails on page 13
- Creating Campaigns on page 14
- Selecting Campaign Recipients on page 16
- Creating Email Content on page 17
- Designing the Email Message Header on page 17
- Designing the Email Message Body on page 19
- Creating a Text Email on page 36
- Scheduling the Email Campaign on page 38

Creating Marketing Emails

Email Marketing On Demand is seamlessly integrated with Siebel CRM On Demand's Campaign Management functionality. This provides marketing professionals with a powerful, integrated tool for creating professional-quality email campaigns based on customer information in Siebel CRM On Demand.

As a Marketing professional, you are guided through the process of creating rich HTML and text emails. You also have access to powerful conditional messaging capabilities for precise personalization, and can track delivery and responses.

Email Marketing On Demand is a comprehensive, permission-based and scalable email marketing solution. With it, you can plan, create, test, execute, and track targeted, personalized email communications.

Before you begin. To create marketing email content, you must perform the following tasks in Siebel CRM On Demand:

- Create a Campaign record in the Campaigns screen.
- Add the recipients of the email to the Recipients list in the Campaign Detail form for the campaign.
- Click the Setup Email button to begin work on the marketing email.

Then, in Siebel Email Marketing, to create a marketing email, perform the following tasks:

1. “Designing the Email Message Header” on page 17
2. “Designing the Email Message Body” on page 19
Creating Campaigns

The Siebel CRM On Demand Campaign Homepage is the starting point for managing campaigns. The Email Marketing On Demand help provides information on selected campaign features as they relate to Email Marketing On Demand.

For complete information about campaigns, see the help for Siebel CRM On Demand.

Campaign Fields

Use the Campaign Edit page in Siebel CRM On Demand to add a campaign or update details for an existing campaign. The Campaign Edit page shows the complete set of fields for a campaign.

**TIP:** You can also edit campaigns on the Campaign List page and the Campaign Detail page in Siebel CRM On Demand.

**NOTE:** Company administrators can customize your application in a variety of ways, such as changing names for record types, fields, and options in drop-down lists. Therefore, the information you see onscreen may differ from the standard information described in this table.
Table 4 provides additional information about campaign fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Key Campaign Information</strong></td>
<td></td>
</tr>
<tr>
<td>Source Code</td>
<td>(Required) Campaign identifier code. Make sure the code you enter is unique.</td>
</tr>
<tr>
<td>Campaign Name</td>
<td>(Required) Descriptive name of the campaign.</td>
</tr>
<tr>
<td>Campaign Type</td>
<td>Type of campaign, such as Advertisement, Direct Mail, Email, Event - Other, Event - Seminar, Event - Trade Show, List - Purchased, List - Rented, Other, Referral - Employee, Referral - External, or Web site.</td>
</tr>
<tr>
<td>Objective</td>
<td>Description of the campaign's objective, such as &quot;To increase sales by 10%.&quot;</td>
</tr>
<tr>
<td>Audience</td>
<td>Target audience of the campaign.</td>
</tr>
<tr>
<td>Offer</td>
<td>Description of the product or service the campaign is offering.</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>Campaign status, such as:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Active</strong>. Start date is in the past and end date is in the future</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Completed</strong>. Start and end dates are in the past.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Planned</strong>. Start and end dates are in the future.</td>
</tr>
<tr>
<td></td>
<td>When you use Email Marketing On Demand, the status is automatically updated to Completed when the outbound emails are processed.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Date and time the campaign starts. Defaults to the current date and time. You can use the calendar controls to change this date.</td>
</tr>
<tr>
<td>End Date</td>
<td>Date and time the campaign is scheduled to be completed. Defaults to the current date and time. You can use the calendar controls to change this date.</td>
</tr>
<tr>
<td><strong>Campaign Plan Information</strong></td>
<td></td>
</tr>
<tr>
<td>Revenue Target</td>
<td>Revenue expected to be generated by the campaign.</td>
</tr>
<tr>
<td>Leads Targeted (#)</td>
<td>Number of prospects the campaign targets.</td>
</tr>
</tbody>
</table>
NOTE: While it is possible to reuse a campaign record, this is not recommended other than for initial testing, because it limits the ability to track recipient responses and to measure the success of individual campaigns.

Selecting Campaign Recipients

You can select individual contacts that you want to target for a campaign, or import lists of contacts.

To target individual contacts for a campaign

1. On the Campaign Detail page, scroll down to the Recipients section and do the following:
   - To target contacts one by one, click Add.
   - To remove the contact, click the Remove link in the record row. This disassociates the contact without deleting any records.
2. Save the record.

Using Automated Upload Tools

You can use the Siebel CRM On Demand Import Wizard to import campaign recipients. For more information on importing records, see the Siebel CRM On Demand online help.
Additionally, if your company uses Segmentation Wizard, you can create highly targeted contact lists or segments using multidimensional criteria. The resulting segment can then be associated with a specific campaign using the automated Upload Segments function.

**NOTE:** Segmentation Wizard is a free add-on application that works between Siebel CRM On Demand and Microsoft Excel. To download the Segmentation Wizard application, click the Customer Care or Training Link from any page in Siebel CRM On Demand. This will take you to the Training and Support Center, where you can select the Search Knowledge option and sign in to Oracle MetaLink 3, the Oracle Customer Support Portal. (If you have not yet registered, simply click the Register Now button and follow the instructions.) When you have logged in, click the Downloads link and select Segmentation Wizard.

### Creating Email Content

The steps to create email messages are described in the following sections:

- "Designing the Email Message Header" on page 17
- "Designing the Email Message Body" on page 19

### Designing the Email Message Header

Email message headers include the information shown in the To, From, Reply-To, and Subject boxes of the email that you send.

Before you create a marketing email, your company must:

- Set up the email address to be used as the From address in the marketing email.
- Set up the email address to be used as the Reply-To address in the marketing email.

**To design email message headers**

1. In the Campaign Detail screen of Siebel CRM On Demand, click Setup Email.

   The Manage Email Campaign page appears, displaying Step 1: Design Email Message Headers.
2 Enter values in the fields, as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>The recipient of the email. The default value is ${Contact.Email}, which displays the email address noted in the Email field of the Contact record.</td>
</tr>
<tr>
<td>From</td>
<td>Enter the address that will appear as the From address in the email. The value you enter must be a valid email address or an email address merge field. If you do not enter an email address, the field may be populated with the @emod.crmondemand.com server email address, which could impact the recipient response.</td>
</tr>
<tr>
<td>Reply-To</td>
<td>Enter the address that will appear as the Reply-To address in the email. The value you enter must be a valid email address or an email address merge field. If the recipient replies to the email, the response is sent to the Reply-To address.</td>
</tr>
<tr>
<td>Subject</td>
<td>Enter the subject line for the email. The default value is the Campaign Name entered in the Campaign Detail page.</td>
</tr>
<tr>
<td>Character Set</td>
<td>Select the appropriate character set for the audience of the email. For example, you can select Greek, Thai, or U. S. English to use those alphabets. If you select Unicode, you can use characters from any alphabet, but it is generally easier to type the email if you select a national character set. The default value is Unicode (UTF-8).</td>
</tr>
<tr>
<td>Locale</td>
<td>Select the locale where the email will be sent. This will be used to determine which localized subscribe or unsubscribe pages are presented to the recipients.</td>
</tr>
</tbody>
</table>

**NOTE:** You can use the drop-down lists to the right of the From, Reply-To, and Subject boxes to insert merge fields in these boxes. If these drop-down lists are empty or out of date, you can refresh them with current values by clicking Get Merge Fields. For more information about merge fields, see "Using Merge Fields in Email Content" on page 29.

**Customizing the Reply-To and From Line of the Email**

You may want to personalize the Reply-To or the From line of the email header, to display a name beside the email address (for example, the account owner name).

**To customize the Reply-To or the From line of the Marketing Email**

1 Select the desired name merge field from the drop-down list to the right of the From field.

The From field displays:

\[${Account.Owner Fullname}$\]
Select the corresponding email address merge field from the drop-down list and enclose it in angle brackets <>.

The From field displays:

${Account.Owner Fullname} <${Account.Owner Email Address}>

When customers receive your email, the From line will substitute the Account owner’s name and email address. For example, for account owner Joanne Brown, the From line will display the text as:

Joanne Brown <joanne.brown@crmondemand.com>

Customizing the Subject Line of the Email
You may want to customize the Subject line of the email to include the customer’s name. For example, if the customer’s name is Doug Allen, you could customize the email with the subject:

Doug Allen, you are invited

To customize the subject line of the Marketing Email
1. From the drop-down list to the right of the Subject box, choose Contact.Fullname.

The Subject box contains the text:

${Contact.Fullname}

2. In the subject box, type:

, you are invited.

The Subject box now contains the text:

${Contact.Fullname}, you are invited.

When customers receive emails, the subject line substitutes the customer’s names, so that the customer sees something like:

Doug Allen, you are invited.

Designing the Email Message Body
After you have designed the email message header, you design the body of the email. Email authors use the Email Marketing Editor to enter and make changes to the body of the marketing email.

You can edit and view the email message body in both HTML and plain text versions. The text email is viewed by contacts whose email client applications display only plain text, or who have chosen to receive text format, rather than HTML.

To design the email message body
1. Click Step 2: Design Email Message Body.
2 In the HTML Edit tab, if desired, click the Open icon and choose a template to base this email on.

3 In the HTML Edit tab, enter the body of the email. For more information, see “Using the Email Marketing Editor” on page 20.

4 Click the HTML Preview tab to view the HTML message as it will appear to the contact. For more information, see “Previewing Email Message Content” on page 37.

5 (Optional) Click the HTML Edit tab and edit the message.

6 To create or edit the plain text version of your email:
   a Click the Text Edit tab.
   b Click Generate from HTML.
      The application generates a text message based on the HTML message that you entered.
   c If necessary, edit the text message.
   d Click Text Preview to view the text message as it will appear to the contact.

Detailed instructions on using the tools available in the Email Marketing Editor to create content are provided in the sections that follow.

Using the Email Marketing Editor

You create the HTML email using all the features of the editor, described in the following sections, including merge fields, conditional content, response fields, graphics, and links to documents.

To make changes using the HTML Editor, enter your changes in the workspace. Use the editing toolbar at the top of the HTML Editor to format and work with text. Most of the buttons on the toolbar are the same buttons that appear in standard text editing applications.

**NOTE:** Not all toolbar buttons appear by default. You can add toolbars by right-clicking on the editor bar and choosing the toolbars you want to add.

You can also right-click highlighted text and make selections from the menu to perform some of the same tasks that you perform using the editing toolbar.

For information about more advanced features of the editor, see:

- “Adding Response Hyperlinks” on page 27
- “Using Merge Fields in Email Content” on page 29
- “Using Conditional Content in Email Marketing” on page 31
Table 5 describes how to use the toolbar. Place the cursor over a tool button to view its name.

### Table 5. HTML Editing Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Keystroke</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Cut" /></td>
<td>Ctrl+X</td>
<td>Removes selected text and graphics. Place that data on the clipboard.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(If you later cut or copy more information onto the clipboard, the new</td>
</tr>
<tr>
<td></td>
<td></td>
<td>information overwrites the original information.)</td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Ctrl+C</td>
<td>Copies selected text and graphics to the clipboard.</td>
</tr>
<tr>
<td><img src="image" alt="Paste" /></td>
<td>Ctrl+V</td>
<td>Inserts the most recently cut or copied text and graphics at the current</td>
</tr>
<tr>
<td><img src="image" alt="Paste Text" /></td>
<td>None</td>
<td>Pastes the contents of the clipboard as plain text. This removes all</td>
</tr>
<tr>
<td><img src="image" alt="Replace" /></td>
<td>None</td>
<td>Launches the Search and Replace dialog box. The dialog searches for</td>
</tr>
<tr>
<td><img src="image" alt="Find Next" /></td>
<td>None</td>
<td>Finds next occurrence of the string entered into the Find What field</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Ctrl+P</td>
<td>Prints the editor content.</td>
</tr>
<tr>
<td><img src="image" alt="Undo" /></td>
<td>Ctrl+Z</td>
<td>Reverses the most recent action, as if it never occurred. You can undo</td>
</tr>
<tr>
<td><img src="image" alt="Redo" /></td>
<td>Ctrl+Y</td>
<td>Reverses the undo action.</td>
</tr>
<tr>
<td><img src="image" alt="Spell Check" /> (manual)</td>
<td>None</td>
<td>Begins spell checker.</td>
</tr>
<tr>
<td><img src="image" alt="Spell Check" /> (automatic)</td>
<td>None</td>
<td>Turns on or off spell check as-you-type feature.</td>
</tr>
<tr>
<td><img src="image" alt="Bookmark" /></td>
<td>None</td>
<td>Creates a bookmark. A bookmark identifies a location on a page. You can</td>
</tr>
<tr>
<td><img src="image" alt="Edit Hyperlink" /></td>
<td>None</td>
<td>Changes information about a hyperlink.</td>
</tr>
<tr>
<td><img src="image" alt="Remove Link" /></td>
<td>None</td>
<td>Removes a hyperlink.</td>
</tr>
<tr>
<td><img src="image" alt="Horizontal Line" /></td>
<td>None</td>
<td>Inserts a horizontal line.</td>
</tr>
</tbody>
</table>
Table 5. HTML Editing Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Keystroke</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>None</td>
<td>Inserts or edits a table.</td>
</tr>
<tr>
<td>Edit in Word</td>
<td>None</td>
<td>Edits content in Microsoft Word.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> This is not a best practice. For more information, see Editing in Microsoft Word on page 27.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clear Content</td>
<td>None</td>
<td>Clears the selected content.</td>
</tr>
<tr>
<td>Find an Email Template</td>
<td>None</td>
<td>Browses for an email template.</td>
</tr>
<tr>
<td>Link to Document</td>
<td>None</td>
<td>Inserts a hyperlink to a document.</td>
</tr>
<tr>
<td>Insert Picture</td>
<td>None</td>
<td>Inserts a picture.</td>
</tr>
<tr>
<td>File Upload</td>
<td>None</td>
<td>Uploads any external files (such as images) to the server.</td>
</tr>
<tr>
<td>View as WYSIWYG</td>
<td>None</td>
<td>Displays the page content as WYSIWYG (What You See Is What You Get).</td>
</tr>
<tr>
<td>WYSIWYG is the ability to see in the editor what will appear when a recipient views the email.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>View Source</td>
<td>None</td>
<td>Displays the email content as HTML.</td>
</tr>
<tr>
<td>Number</td>
<td>None</td>
<td>Makes this line a numbered step. If the line above this line is:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ not numbered, makes this step 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ numbered, makes this the next sequential step number</td>
</tr>
<tr>
<td>Bullet</td>
<td>None</td>
<td>Begins the line on which the cursor rests (or all selected lines) with a bullet (•).</td>
</tr>
<tr>
<td>Indent</td>
<td>None</td>
<td>Increases or decreases the current line's distance from the left margin.</td>
</tr>
<tr>
<td>Left, Center, and Right Justify</td>
<td>None</td>
<td>Aligns paragraph:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ left (with ragged right)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ centered</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ right (with ragged left)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ both sides</td>
</tr>
<tr>
<td>Remove Style</td>
<td>None</td>
<td>Removes all style information from selected text.</td>
</tr>
</tbody>
</table>
### Table 5. HTML Editing Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Keystroke</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style</td>
<td>None</td>
<td>Picks a style and applies to selected text.</td>
</tr>
<tr>
<td>[Apply Style]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td>None</td>
<td>Changes the heading size.</td>
</tr>
<tr>
<td>Heading Size</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Times New Roman</td>
<td>None</td>
<td>Changes the font style.</td>
</tr>
<tr>
<td>Font Style</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 (12 pt)</td>
<td>None</td>
<td>Changes the font size.</td>
</tr>
<tr>
<td>Font Size</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Font Color</td>
<td>None</td>
<td>Changes the font color.</td>
</tr>
<tr>
<td>Background Color</td>
<td>None</td>
<td>Changes the background color of the text.</td>
</tr>
<tr>
<td>NOTE: To remove background color from selected text, click the Normal button ( ).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bold</td>
<td>Ctrl+B</td>
<td>Makes the text bold.</td>
</tr>
<tr>
<td>Italic</td>
<td>Ctrl+I</td>
<td>Makes the text italic.</td>
</tr>
<tr>
<td>Underline</td>
<td>Ctrl+U</td>
<td>Makes the text underlined.</td>
</tr>
<tr>
<td>Normal</td>
<td>None</td>
<td>Removes all formatting from selected text.</td>
</tr>
<tr>
<td>Superscript</td>
<td>None</td>
<td>Makes the selected text a superscript.</td>
</tr>
<tr>
<td>Subscript</td>
<td>None</td>
<td>Makes the selected text a subscript.</td>
</tr>
<tr>
<td>Copyright</td>
<td>None</td>
<td>Inserts copyright symbol.</td>
</tr>
<tr>
<td>Registered Trademark</td>
<td>None</td>
<td>Inserts registered trademark symbol.</td>
</tr>
</tbody>
</table>
NOTE: As with other HTML editors, when you press Enter, you create a new paragraph with spacing of 1.5 lines. If you want to create a line break, press and hold the Shift key while you press Enter.

**Position Objects Options**
These buttons let you specify the absolute position of elements such as pictures, tables, and so on, anywhere on a page. *Table 6* describes the object positioning buttons.

**NOTE:** Not all toolbar buttons appear by default. You can add toolbars by right-clicking on the editor bar and choosing the toolbars you want to add.

**Table 6. Object positioning buttons**

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>TM</td>
<td>Inserts trademark symbol.</td>
</tr>
<tr>
<td>Special Characters</td>
<td>Inserts special characters (such as £, µ, Ñ) from a drop down list.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>Moves selected table or image anywhere on the screen.</td>
</tr>
<tr>
<td>Lock</td>
<td>Locks selected table or image at its current screen position. Nothing can move a locked object. To unlock the object, click the button again.</td>
</tr>
<tr>
<td>Move to Front</td>
<td>If two or more images overlay each other, moves the selected image in front of the others.</td>
</tr>
<tr>
<td>Move to Back</td>
<td>If two or more images overlay each other, moves the selected image behind the others.</td>
</tr>
<tr>
<td>Above Text</td>
<td>If text overlays an image, moves the image in front of the text.</td>
</tr>
<tr>
<td>Below Text</td>
<td>If an image overlays text, moves the text in front of the image.</td>
</tr>
</tbody>
</table>

**Text Direction Options**
The text direction menu options allow bi-directional editing of text, which is useful for Arabic, Farsi and Hebrew. The client computer must also support the language.
To display the text direction toolbar, right-click on the editor bar and choose Text Direction.

![text direction toolbar]

The text buttons determine the editing direction, while the edit buttons determine the side of the editor that displays the scroll bar.

For right-to-left languages, such as Arabic, Farsi and Hebrew, the text editing is right to left, and the scroll bar is on the left side.

For western European languages, the text editing is left to right, and the scroll bar is on the right side. Table 7 describes the text direction buttons.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left-Right Text</td>
<td>Text is entered left to right.</td>
</tr>
<tr>
<td>Right-Left Text</td>
<td>Text is entered right to left.</td>
</tr>
<tr>
<td>Left-Right Edit</td>
<td>The vertical scroll bar appears on the right side of the window.</td>
</tr>
<tr>
<td>Right-Left Edit</td>
<td>The vertical scroll bar appears on the left side of the window.</td>
</tr>
</tbody>
</table>

**Using an Existing HTML Template**

If your company has established standard email templates, or you want to reuse a previous email design for your current campaign, you can select an existing template from the Email Marketing Library. This shortens the process of creating email content as it allows you to select any previous campaign’s creative and use it as a template.

**To insert an email template**

1. From the HTML email editor, click the Find an Email Template button.
   
   The select an email template pop up window appears, with the recently used templates listed first. You can sort the templates or search for a specific file.

2. To preview the content, click the View link.

3. To select a template, click on the name.
   
   The template is inserted into your email.

**NOTE:** Each email campaign is automatically saved as a template under the Campaign Name. For example, if your Campaign Name is November 2007 Newsletter, the template will be added to the Email Marketing Library under the same name.

You can add a template from an external location, such as the desktop.
To insert a template from an external file

1. On the Edit HTML tab, click the Find an Email Template button. The Select an email template pop up window appears.
2. Click the New button in the template library.
3. Click Browse, navigate to the HTML file you want, and select it.
4. Apply the appropriate encoding from the Character Set drop-down list, then click Submit.

The HTML content appears in the body of your email.

Copying Information from Other Applications
You can copy information from most other Windows applications into Email Marketing On Demand and retain the formatting from the original application.

To copy formatted HTML content from another source

1. Sign on to the application in which the information resides.
2. Select the information to be copied and press CTRL+C.
3. Go to the Email Marketing On Demand HTML editor window and click the View as WYSIWYG button. See Table 5 on page 21.
4. Press CTRL+V to paste the selected information into the Email Marketing On Demand HTML editor workspace.
5. You can then click the HTML Preview tab to see how your content will appear when a recipient views your email.

You can copy unformatted HTML source code from another source, such as a text editor.

To copy HTML source code from another source

1. Sign on to the application in which the information resides.
2. Select the information to be copied and press CTRL+C.
3. Go to the Email Marketing On Demand HTML editor window and click the View Source button. See Table 5 on page 21.
4. Press CTRL+V to paste the selected information into the Email Marketing On Demand HTML editor workspace.
5. You can then click the View as WYSIWYG button to see the HTML layout of your content.

Experiment by copying from different sources to test the results.
Editing in Microsoft Word
If your computer has Microsoft Word 2000 or greater, you can edit content within Microsoft Word. You may prefer to do this if you are familiar with the Microsoft Word user interface, and want to use additional functionality available in Microsoft Word.

NOTE: It is not a best practice to use Word to generate HTML email content, because some Microsoft Word formatting may be incompatible with HTML and therefore cannot be transferred to the Email Marketing On Demand HTML editor.

To edit with Microsoft Word
1. From the HTML Edit tab in the editor, click the Microsoft Word toolbar button. For a list of buttons, see Table 5 on page 21.
   A dialog may appear, warning you that some Microsoft Word formatting may not be transferred back to Email Marketing On Demand. Click Yes if you still want to edit in Microsoft Word.
   Microsoft Word opens. Any content that was in the HTML editor when you clicked the Microsoft Word button is copied to Microsoft Word.
2. Edit the content as necessary.
3. Click File > Close.
4. When another warning like the one in Step 1 appears, click Yes to copy the edited content back to Email Marketing On Demand.
5. If you want to restore the content to the way it was before you edited it in Microsoft Word, click the Undo button. For a list of buttons, see Table 5 on page 21.
6. If you want to restore the Microsoft Word changes after clicking Undo, click the redo button. For a list of buttons, see Table 5 on page 21.

Adding Response Hyperlinks
You can include a variety of response links in an email campaign. Whenever a recipient receives the email and clicks on the hyperlink for a response, a response is automatically created for the CRM On Demand campaign.

Each recipient response is recorded as part of the Siebel CRM On Demand Campaign record. This provides you with a way to measure the response rate to an email campaign. The following types of response links are available:

- **Global Opt-In.** The recipient can click this link to subscribe to all emails sent by the company. Unlike the Global Opt-Out response, there is no automated update associated with the Global Opt-in link.
Global Opt-Out. The recipient can click this link to unsubscribe from all emails sent by the company. If the recipient clicks this link, the Never Email checkbox of the Contact record is checked, and the recipient sees a confirmation message stating that they have been unsubscribed.

NOTE: Email Marketing On Demand does not send emails to users who have the Never Email flag checked in their Contact record. If a recipient who previously opted out changes their mind and asks to be added back, you can re-enable them by clearing the Never Email checkbox.

Opt-In to List. If the recipient clicks this link, the click is recorded in the Response Status field for the Campaign Recipient record. Your company can use this information when making queries to identify contacts for future campaigns, or to identify recipients that are interested in receiving similar types of communications.

Opt-Out from List. If the recipient clicks this link, the click is recorded in the Response Status field for the Campaign Recipient record. Your company must take this into account when making queries to identify contacts for future campaigns, to ensure that you exclude customers who have indicated no interest in receiving further communications about a specific product or service, or emails of a specific type.

Track Message Open. If you add this tag, the Response Status field for the Campaign Recipient record indicates whether or not the recipient has opened the email. This tag can be inserted anywhere in the email and is triggered automatically when the recipient opens their email.

NOTE: HTML is required in order to use the $(TrackMsgOpen) tag, which adds a small 1 x 1 GIF to the body of the email. While the image is not seen by the recipient, if their email client does not allow the download of graphics, or if they read the email from a preview window, the Message Opened response will not be sent.

Track URL. If you select this option, the Response Status field for the Campaign Recipient record indicates whether or not the recipient has clicked a link. You can see more specific information about which URL was clicked in Campaign Response History Analytics reports.

To add a response hyperlink

1. Display the email in the HTML editor, as described in “Designing the Email Message Body” on page 19.
2. Place the cursor at the location where you want to add the response hyperlink.
3. In the Personalization Items toolbar, select Responses and then select the type of response hyperlink.
4. (Optional) To specify the display text for the response link, enter the value in the text box to the left of the Insert button.
5. Click Insert.
6. Right-click on the inserted link and select the Hyperlink menu option to edit the response link properties.

The response hyperlink appears in the email. It is not an active hyperlink in the HTML editor, but it will be active in the email sent to the contact.
Using Merge Fields in Email Content

Use merge fields to customize email content for each recipient. Contacts can have multiple fields associated with them, where each field defines an attribute, such as their last name, their first name, or their account number. For each unique contact, the value of these fields may differ. You insert the merge field personalization element in the text, and then the value of the Contact field is populated into the text where you inserted the merge field.

You can insert any Account, Contact, or Campaign merge field from the Personalization Elements drop-down menu by selecting and inserting it into the following places:

- **Body of the email.** The value appears in the body of the email.
- **Subject of the email.** The value appears in the subject line of the email.
- **From Address.** The value appears in the From line of the email.
- **Reply To Address.** The value appears in the Reply To line of the email.

The following examples show how the personalization item appears in the email editor, and then when received by the contact, for two contacts with the first names of Mary and John.

Before population in the treatment text:

Hello ${Contact.First Name}!

When Mary receives the treatment, she gets the following:

Hello Mary!

When John receives the treatment, he gets the following:

Hello John!

In some records, a value might not exist for a merge field. For example, the contact record field from which the value is derived may be empty. When the selected merge field is not populated, the merge field may default to one of the following values:

- **Empty string.** The value is an empty string (a string containing no characters).
- **Unspecified.** The value is the word Unspecified.

To insert a merge field in the body of the email

1. Display the email in the HTML editor, as described in “Designing the Email Message Body” on page 19.
2. Place the cursor in the location where you want the merge field to appear.
3. From the Personalization Items drop-down list, choose Merge Fields.
4. In the next drop-down list, select the type of merge field: Contact, Account, or Campaign.
5. In the next drop-down list, select the field record.
6. Click the Insert button.

The merge field appears in the email.
Tracking Dynamic URLs
You can use a template variable in the actual URL part of a tracked URL. This allows the destination URL to be different for different recipients.

For example, suppose you are running a sports-related Web site and you have created Web pages with URLs similar to the following:

- baseball.mycompany.com
- football.mycompany.com
- basketball.mycompany.com
- golf.mycompany.com

Further, the database that is used to do your mailings includes a column that identifies a favorite sport, which will be one of baseball, football, basketball, and so on. You want to include a link in your email that will take recipients to the site corresponding to their respective favorites. Assuming that the database column is called `favorite_sport`, you could set up a URL command similar to the following:

```url "http://${favorite_sport}.mycompany"`}
```

When the mailing is sent, John, whose favorite sport is basketball, will have a link to:


Mary, whose favorite sport is football, will have a link to:


Template variables can be used in any part of the URL, but you must make sure that the resulting string, after the value(s) of the variable(s) have been substituted, is a complete and valid URL, including the http://.

NOTE: When a variable is used within a URL, the resultant URL that appears in the recipients’ email is significantly longer than the resultant URL when no variables are used. This is normal behavior.

Including Parameters with URLs
You can include HTML query parameters within a URL. The values of the parameters can be template merge fields, which are automatically personalized for every recipient. For example, if you have a Web page that requires a login name or email address, you can include a link with the customer’s name in the URL. Then, when the customer clicks the link, they are brought directly to their personal login page.

Based on this example, you could create a tracked URL similar to:

http://www.mycompany.com/welcome?name=${Contact.Email}
Using Conditional Content in Email Marketing

Conditional content provides the ability to present relevant information to individual email recipients without having to create multiple messages. There are two ways to generate conditional content within an email:

- Named Blocks personalization
- If-Then-Else personalization

**NOTE:** Conditional content and merge fields are available in both HTML and Text format emails.

**Named Blocks Personalization**

Named blocks determine whether to insert a block of text or HTML into an outgoing email by comparing one string to another:

- If the two strings are identical, the block is inserted.
- If the two strings are not identical, the block is not inserted.

**NOTE:** The string comparison is case sensitive.

Table 8 lists components of the Named Blocks personalization element.

<table>
<thead>
<tr>
<th>Personalization Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$(DefineBlock &quot;MatchString&quot;)</td>
<td>Starts a block of text or HTML that is inserted in place of an Insert Block component when MatchString is identical to the MatchString of the Insert Block component.</td>
</tr>
<tr>
<td>$(EndBlock)</td>
<td>Ends a block of text or HTML that was started with the Define Block component.</td>
</tr>
<tr>
<td>$(InsertBlock &quot;MatchString&quot;)</td>
<td>A block of text or HTML is inserted at the location of this component when MatchString is identical to the MatchString of a Define Block component.</td>
</tr>
</tbody>
</table>

The following is an example of a Named Blocks personalization element:

```html
<P>You live in $(InsertBlock "${Account.Country}").</P>
$(DefineBlock "USA")
<B>the United States</B>
$(EndBlock)

$(DefineBlock "India")
<B>India</B>
$(EndBlock)
```

In this example, if USA is entered in the Country field of the Account record, the following sentence appears:
You live in the United States.

**NOTE:** If a given recipient has no associated value for a named block variable listed in the InsertBlock MatchString component, then nothing is inserted into the message for that block.

**To insert named blocks**

1. Display the email in the HTML editor, as described in "Designing the Email Message Body" on page 19.
2. Place the cursor in the location where you want the Insert Block.
3. Create the Insert Block statement:
   a. In the Personalization Toolbar, select Insert Block from the drop-down list at the far left.
   b. In the next drop-down list, select the record the field comes from: Contact, Account, or Campaign.
   c. In the next drop-down list, select the field in the record.
   d. Click Insert.
4. Create a Define Block component:
   a. In the drop-down list immediately above the email and at the far left, select Create Block. A $(DefineBlock "") and $(EndBlock) statement appear in the text.
   b. Type a field value within the quotation marks of the $(DefineBlock "") statement. This is the value that will drive the content displayed in the block.
   c. Type the text that you want to insert into the email between the $(DefineBlock "") and $(EndBlock) tags.
5. Repeat Step 4 until you have added all the Define Block components that you need.

**If-Then-Else Personalization**

If-Then-Else personalization provides the ability to insert or remove text within your email content, based on whether a Merge field value is defined. The merge field is defined if it contains a value or, for numeric merge fields, if the value is not 0 (zero).

- If the merge field is defined, the text remains in the outgoing email.
- If the merge field is not defined, the text is removed from the outgoing email.
Table 9 lists components of the If-Then-Else personalization element.

<table>
<thead>
<tr>
<th>Personalization Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$(if {Record.FieldName})</td>
<td>The If component is used to start an If-Then-Else personalization element. It determines whether the merge field named [FieldName] has a value. If there is a value for [FieldName], the text between this If-Then-Else component and the next If-Then-Else component is not removed from the email.</td>
</tr>
<tr>
<td>$(elseif {Record.FieldName})</td>
<td>The Else-If component is the same as the If component, except that it is used within the If-Then-Else personalization element, not at its beginning.</td>
</tr>
<tr>
<td>$(else)</td>
<td>The Else component is used after a $(if) or $(elseif) component. If the preceding $(if) or $(elseif) component removes the preceding block of text or HTML from the email, the $(else) component’s block of text or HTML is included in the email. If the preceding $(if) or $(elseif) component does not remove its block of text or HTML, the $(else) component’s block of text or HTML is not included in the email.</td>
</tr>
<tr>
<td>$(endif)</td>
<td>The End-If component closes the If-Then-Else personalization element.</td>
</tr>
</tbody>
</table>

The following is an example of an If-Then-Else personalization element.

```
$(if ${Contact.First Name})
  Dear ${Contact.First Name}${Contact.Last Name},
$(else)
  Dear Mr. or Ms. ${Contact.Last Name},
$(endif)
```

- If the Contact.First Name field is defined, the email will begin with "Dear First Name Last Name".
- If the Contact.First Name field is not defined, the email will begin with "Dear Mr. or Ms. Last Name".

You can use If-Then-Else statements similarly to Block statements, by including operators such as Equal to, Starts with, or Contains. You can select these operators from a drop-down list when you generate If or If-Else statements. Unlike Blocks, this allows you to insert conditional content where the variable is true or not true.

For example, to customize the email with a condition for accounts in the state of California, you use the statement:

```
$(if ${Account.Bill to State} == "CA")
  Join us all month long for special events and workshops held in each of our California locations.
$(else)
```

Join us all month long for weekly online workshops and special offers at www.mycompany.com/events.
\$(endif)

You can also nest If-Then-Else statements, placing one within another.

**NOTE:** The components of personalization elements must be placed in the correct locations in the text. Any incorrect placement will cause an error.

**To insert if-then statements**

1. Display the email in the HTML editor, as described in “Designing the Email Message Body” on page 19.
2. Place the cursor in the location where you want the If-Then statement.
3. Create the If or Elseif statement:
   a. In the drop-down list immediately above the email and at the far left, select either If or Elseif.
   b. In the next drop-down list, select the record the field comes from: Contact, Account, or Campaign.
   c. In the next drop-down list, select the field in the record.
   d. In the next drop-down list, select the operator.
   e. In the next text box, enter the value that the field is compared with.
   f. Click Insert.
4. Below the If or Elseif statement, enter the text that will appear if the condition in the statement is satisfied.
5. At the end of the entire If-Then-Else statement, enter $(endif).

**Inserting Images in Email Content**

You can add a graphic image to the body of your email. The image must exist in the email marketing library on your computer, or on a network folder available to your computer, and must be in .gif or .jpg format.

There is no limit on image file size. However, because file size affects the time it takes for an image to render for the recipient, and contributes to your Marketing Library storage, it is recommended that you keep image sizes low. For information on Marketing Library storage, see “Viewing Email Marketing Library Usage” on page 11.

**NOTE:** Email Marketing On Demand only supports .gif and .jpg format image files. If you try to insert an unsupported file type, an error message appears, and you cannot insert the image.

**To insert an image in an email**

1. Display the email in the HTML editor, as described in “Designing the Email Message Body” on page 19.
2 Place the cursor in the location where you want the image to appear and click the Insert Picture button. For a list of buttons, see Table 5 on page 21.

The Picture Properties dialog box appears.

3 To access your email marketing image library, click the Select New File button.

The email marketing library popup window displays thumbnail images of the available files.

4 Do one of the following:
   a To select a file from the library:
      □ Click the thumbnail of the image you want.
      □ In the Picture Properties dialog box, click OK.
   b To select an image from a folder on your computer or your network:
      □ Click the New button on the lower right side of the image library window.
      □ Click Browse and navigate to the folder that contains the image.
      □ Select the image file, type a file name and folder (optional), and click OK.
      □ In the Picture Properties dialog box, click OK.

5 Click in the Enter a description for the file field, and enter a title to describe the file.

6 After you insert the picture, the title appears in the bottom left corner of the dialog box, to identify the picture within the Email Marketing On Demand Library.

   NOTE: The title is also the alt text for the image. The alt text appears in place of the image on the Web page if the image itself cannot display for any reason.

7 If you want to view a picture before inserting it, click Preview (on the right side of the dialog box). Information about the picture’s file size, width and height also appears in the dialog box. Here, you can change the picture’s properties.

8 Click OK to insert the picture into the editor.

You can also delete a picture.

To delete a picture
1 Place the cursor over the picture.
2 Click the picture to select it.
3 Click the Cut button.

Associating Documents with an Email

You can associate literature items, such as white papers, presentations, brochures, advertising material, and product specifications with your email campaign. Using the Email Marketing On Demand document library, you can include a link within your email message that allows the recipient to download the document directly from the library.
This decreases the chance that the delivery of your message will be blocked, and provides the added benefit that you can track who has downloaded the document based on click-thrus for the associated link.

**To associate a document with an email**

1. Display the email in the HTML editor, as described in "Designing the Email Message Body" on page 19.

2. Place the cursor in the location where you want the document link to appear, then click the Link to Document button.
   - For a list of buttons, see Table 5 on page 21.
   - The Select Document window for the Email Marketing Library appears.

3. To associate a document from the library:
   - Navigate to, or search for, the file you want to associate, and click on the file name to select it.
   - A link to the document appears in the body of the email.

4. To associate a document from an external folder:
   - Click the New button in the document library.
   - Click Browse, navigate to the document you want to associate, and select it.
   - Type in a display name for the document, then click Save.
   - A link to the document appears in the body of the email.

You may associate as many documents as necessary by repeating Step 2 and Step 3 for each document from the library, or Step 2 and Step 4 for each document from an external folder.

**NOTE:** The link text will default to the file name saved in the email marketing library. You can modify the display name that appears in your email content by right clicking on the link and selecting the Hyperlink... option from the menu that appears. Change the information in the Text field and click OK when finished.

**Creating a Text Email**

You can create a text version of your email content directly from the HTML, thus streamlining your efforts. This creates a text template from the HTML template. You may need to adjust the formatting prior to sending.

**To generate a text email from HTML**

1. From the HTML email editor, click the Text Edit tab.
2 Click the Generate from HTML button.

A text only version of your email content appears in the editor window.

**NOTE:** All HTML tags and element, such as images and formatting, are removed from the content. However, the personalization elements are retained, as both conditional content and merge fields are supported in text mode.

You can generate a text email from a template.

**To generate a text email from a template**

1 From the HTML email editor, click the Text Edit tab.

2 Click the Find an Email Template button.

   The Select an email template popup window appears, with the most recently used templates listed first. You can sort the templates, search for a specific file, or click View to preview the content.

3 To select a template, click on the name.

   The text is inserted into the body of your email.

   **NOTE:** Each email campaign is automatically saved as a template under the Campaign Name. For example, if your Campaign Name is *November 2007 Newsletter*, the template is added to the Email Marketing Library under the same name.

You can generate a text email from an external file.

**To generate a text email from an external file**

1 From the Text Edit tab, click the Find an Email Template button.

   The Select an email template popup window opens.

2 In the template library, click New.

3 Click Browse, navigate to the file you want, and select it.

4 Apply the appropriate encoding from the Character Set drop-down list, then click Submit.

   The text content appears in the body of your email.

**Previewing Email Message Content**

After you have specified who will receive your email, and have uploaded or created the content of your message, you can preview it, to see exactly how it will appear to your recipients.
Previewing an Email Message

Before sending your email, you should preview it first. The Email Marketing On Demand editor provides the ability to:

- Confirm how your HTML will appear to the recipient
- Test any of the conditional content that you have added
- Ensure that your text formats correctly when merged with actual customer data.

To preview your email

1. Click the HTML Preview or Text Preview tab.
2. Click the Set Merge Field Values button.
3. Enter sample values for the merge fields included in the message header and body, then click View.
   The preview message is displayed, with the sample values you entered inserted in the email header and body, in place of the merge fields.

Sending a Test Email Message

You can send a test email, based on your preview content, before you send it to the actual campaign recipients.

NOTE: The Test Email function is only available from the HTML Preview tab.

To send a test email message

1. In the email editor, click the HTML Preview tab.
2. Follow the steps to set merge field values as described in "Previewing an Email Message" on page 38.
3. Click View.
   A text box appears to the right of the Set Merge Field Values button.
4. Enter the email addresses, separated by commas, that you would like to send the test message to for review.
5. To send the message, click the Test Email button.
   NOTE: The test email message content will reflect the sample values entered in Step 2.

Scheduling the Email Campaign

After you have reviewed the test email message and are satisfied with the results, you can schedule the email campaign to specify exactly when these emails will be sent.
Before you schedule your mailing, you can display a total count of the targeted recipients. The result of this check helps to confirm that your selection of recipients is on target.

To count targeted recipients
1. From the Email Marketing On Demand editor, click Step 3: Schedule Email Campaign.
2. Click the Get Recipient Count button.

The number of Total Recipients appears to the right of the schedule settings page.

NOTE: The Email Marketing On Demand server sends out email in batches of 100 messages, to reduce the possibility that receiving networks will flag your messages as spam.

You can schedule the email campaign to specify when the emails will be sent.

To schedule the email campaign
1. From the Email Marketing On Demand editor, click Step 3: Schedule Email Campaign.
2. Click the Scheduled At radio button.
3. Click the Calendar icon to the right of the Scheduled At box.
4. On the calendar:
   a. Select the date when the email will be sent. If necessary, click the arrows to the left or right of the month name to go to the previous or next month.
   b. Select the time when the email will be sent.
   c. Click Close.

   NOTE: To send your email immediately, select the default time displayed in the calendar popup, then override with the current time.
5. After you have specified a date and time to send your email, click the Save button to complete the scheduling process.

   A message prompts you to confirm that you want to send your mailing at the scheduled time.
6. Click YES to continue and exit Email Marketing On Demand or CANCEL to remain in the editor and review further.

At the scheduled time, the system will send the configured email message to each campaign recipient. When the process begins, the campaign status will be set to Active. When the last email has been processed, the campaign status will be set to Completed.

While the mailing is in progress, you can check the current status through the Email Marketing Administration > Outbound Email Usage page.

NOTE: Email Marketing On Demand currently supports only a 12-hour clock, therefore you must select the appropriate time and the corresponding AM or PM option. The time selected is based on the user's location, as designated by the Time Zone setting on their EMOD User record. To ensure successful delivery of your email messages, this value must be set correctly.
This chapter describes how to review and analyze the success of your campaigns. It includes the following topics:

- Recording Responses to Campaigns on page 41
- Reviewing Campaign Responses on page 42
- Email Campaign Responses and Statistics on page 44
- Generating Delivery Statistics on page 45
- Generating Response Analyses on page 45

### Recording Responses to Campaigns

Whenever contacts respond to a campaign through any channel, such as email, the Web, a call center, or a sales representative, their responses may be captured in detail using the Campaign Recipient Responses page. Using Response views, you can determine which contacts to pursue as leads or opportunities.

When you want to record the response to a campaign; for example, that a recipient attended an event, you can track this information in the campaign recipient section.

*To record a response to a campaign*

1. Select the campaign.
2. On the Campaign Detail page, scroll down to the Recipients section, and click Edit for the contact whose response you want to record.
   
   Some fields are described in the following table.
### Reviewing Campaign Responses

Using Oracle Business Intelligence (BI), you can create Campaign Response History charts and reports to analyze the responses to your campaigns in areas such as delivery and click-throughs to opportunities, revenue generated, campaign offers, and so on.

### Measuring Campaign Effectiveness

#### Reviewing Campaign Responses

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery Status</td>
<td>The default values are Pending, Sent, Soft Bounce, Hard Bounce, Unknown Bounce, Received, and Opened. However, your company administrator can customize the options in this drop-down list.</td>
</tr>
<tr>
<td></td>
<td>For Email Marketing On Demand, the recipient delivery status is automatically updated for failed deliveries only (Soft Bounce, Hard Bounce, or Unknown Bounce).</td>
</tr>
<tr>
<td></td>
<td>A Hard Bounce represents an undeliverable email message, such as a recipient with an invalid email address. A Hard Bounce is not re-queued for delivery, and the recipient’s contact record is automatically flagged as Never Email.</td>
</tr>
<tr>
<td></td>
<td>A Soft Bounce represents a blocked delivery, for example the Recipient’s mailbox is full or the receiving Email Server is not responding. A Soft Bounce is re-queued for later delivery (up to three attempts).</td>
</tr>
<tr>
<td>Response Status</td>
<td>The standard values are Click-thru, RSVP - Will Attend, RSVP - Will Not Attend, Attended, Converted to Lead, Requested More Info, Opt-In to List, Opt-Out from List, Global Opt-In, Global Opt-Out, and Message Opened. However, your company administrator can customize the options in this drop-down list.</td>
</tr>
<tr>
<td></td>
<td>For Email Marketing On Demand, the response status is automatically updated (for the Click-thru, Opt-In to List, Opt-Out from List, Global Opt-In, Global Opt-Out, or Message Opened values only).</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Only the most recent response is reflected in the Siebel CRM On Demand Campaign Detail page for each Recipient. For example, if a Recipient opens the email message and then clicks on the Opt-In to List link, the Opt-In response is what will be reflected in Siebel CRM On Demand under Campaign Recipients.</td>
</tr>
</tbody>
</table>

4 Save the record.
Managing Bounced Emails

The Email Marketing On Demand server can distinguish between emails with the status of hard and soft bounce:

- Emails with the status of hard bounce are permanent failures.
- Emails with the status of soft bounce are temporary delivery failures.

If an email with the status of hard bounce is sent to a bad address, the recipient contact is immediately flagged as Never Email (this occurs for emails with the bounce statuses of Bad Address, Address Moved or Unknown Address only, otherwise emails with the status of hard bounce will be treated as emails with the status of soft bounce and the delivery status recorded against the recipient record.)

After the Never Email flag is set in Siebel CRM On Demand, the Contact receives no further email from within Email Marketing On Demand.

It may not always be possible to resolve the bounce status error, and therefore you may see an additional bounce status type of Unparseable or Unknown Bounce.

Possible reasons for failed (bounced) email messages are as follows:

- Bad Address
- Address Moved
- Bad Sender
- Mailbox Problem
- System Problem
- Network Problem
- Protocol Problem
- Security Problem
- Message Too Large
- Vacation
- Last Resort
- Unknown Code

Tracking Click-Through Responses

Using the Campaign Response History analyses in Oracle Business Intelligence Answers, you can track if and when recipients click on the embedded hyperlinks within your email content. This provides an easy way to measure the response rate to an email campaign such as identifying:

- Which links are being accessed?
- How often links are being accessed?
- When links are being accessed?
By whom links are being accessed?

For example, suppose the following links occur in the same template:

1. $(url "http://www.yourcompany.com" "company-one")
2. $(url "http://www.mycompany.com")

Using the Campaign Response History analyses in Oracle BI Answers, the URL Analysis may look like the information in the following table:

<table>
<thead>
<tr>
<th>URL and Description</th>
<th>Total Clicks</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://www.yourcompany.com">http://www.yourcompany.com</a></td>
<td>100</td>
</tr>
<tr>
<td><a href="http://www.mycompany.com">http://www.mycompany.com</a></td>
<td>50</td>
</tr>
</tbody>
</table>

**Email Campaign Responses and Statistics**

The Campaign Response History reporting subject area provides two types of information relating to an email campaign: Campaign Delivery and Response Status, and Mailing Statistics.

The Campaign Delivery and Response information provides you with detailed information to determine the success of your email campaigns or of your message in reaching the targeted recipients.

The Metrics section provides you with statistical analysis for an email campaign or recipient.

**Analyzing Mailing Delivery Status**

Using the Campaign and Response Metrics sub areas, you can find:

- Campaign status
- Number of messages sent
- Number of messages opened
- Number of soft bounces
- Number of hard bounces
- Number of responders
- Number of responses
- Number of click-thrus
- Number of unsubsribes

You can choose to display mailing delivery status based on a number of different Campaign variables, for example, Campaign Name, Source Code, Campaign Type or Start Date.
Generating Delivery Statistics

The Campaign and Response Metrics information can be used to generate a report to show delivery statistics.

To generate a delivery report:
1. Navigate to the Reports tab in Siebel CRM On Demand.
2. Click the Design Analyses link.
3. Under the Analytics subject areas select Campaign Response History.
4. Select a Campaign variable to run the report against, such as Campaign Name or Source Code.
5. Add a Filter based on Campaign Status, where the field value is equal to Completed.
6. Include the following Response Metrics:
   - # of Recipients
   - # of Hard Bounces
   - # of Soft Bounces
   - # of Open Responses

**NOTE:** The # of Open Responses metric will only reflect opened messages that included the $(trackMsgOpen) tag. For more information, see “Adding Response Hyperlinks” on page 27.

From here you can create an additional view to calculate the total number of messages delivered (\# of Recipients - (# of Hard Bounces + # of Soft Bounces)) and opened, and the estimated open rate of the specified campaign (a percentage of the total messages sent, # of Open Responses/# of messages delivered).

You can present this information in the form of a numerical value, a percentage, and in the form of a bar graph using the layout capabilities of Siebel CRM On Demand Answers.

Other Delivery reports that you may want to create are:
- **Bounce Detail Analysis.** Show the number of messages that failed for each bounce type, as well as a summary of the total number of failed messages.
- **Soft Bounce Detail Analysis.** Show the number of messages that were classified as soft bounces and the bounce types.
- **Hard Bounce Detail Analysis.** Show the number of messages that were classified as hard bounces and the bounce types.

Generating Response Analyses

You can use the Campaign and Response Metrics information to generate a report to show information about recipient response and URL statistics.
To generate a response report:
1. Navigate to the Reports tab in Siebel CRM On Demand.
2. Click the Design Analysis link.
3. Under the Analytics subject area, select Campaign Response History.
4. Select a Campaign variable to run the report against, such as Campaign Name or Source Code.
5. Add a Filter based on Campaign Status, where the field value is equal to Completed.
6. Include the following Response Metrics:
   - # of Recipients
   - # of Hard Bounces
   - # of Soft Bounces
   - # of Responders
   - # of Open Responses
   - # of Click through
   - # of Global Opt-outs

   **NOTE:** The # of Open Responses metric will only reflect opened messages that included the $(trackMsgOpen) tag and the # of Responders reflects the number of recipients that have opened the message or clicked a tracked URL. For more information, see “Adding Response Hyperlinks” on page 27.

Using this information, you can create a combined view that includes the total number of respondents, the number of recipients who unsubscribed, as well as the calculated the response rate and the average number of clicks for each respondent.

A respondent is defined as any recipient who clicks on one or more URLs in an email message.

The response rate is defined as total respondents divided by total messages delivered.

Other Response reports that you may want to create are:

- **Unsubscribe Analysis.** Show the total number of recipients who have unsubscribed. From here you could also create a link to a list view of every recipient who has unsubscribed from the specified email campaign.

- **URL Summary Analysis.** Show information about the URLs and click-through responses in your email message. This report would include a list of the URLs that were embedded in your email message and the number of times each URL was clicked. From here you could also create a link to a list view of every recipient who has clicked on each URL.
This appendix describes best practices you can use to maximize your success and minimize complaints. It includes the following topic:

- Email Marketing Best Practices on page 47

**Email Marketing Best Practices**

As email service providers continue to develop and implement improved filtering systems designed to block spam, marketers must also evolve by increasing their focus on catering to customer preferences and avoiding spam complaints.

In addition to complying with regional email marketing regulations, the following is a list of recommended best practices you should employ to increase deliverability and avoid receiving complaints, thus optimizing the success of your email campaigns:

- **Make sure you have been granted permission to email your recipients.** Permission can be granted through an online opt-in process, or you may have been provided explicit permission offline. Developing a positive relationship with your recipients is the most important step you can take to help your mailings reach their inboxes.

- **Send your recipients only email content that is relevant to what they've requested.** If you start emailing irrelevant offers, they're more likely to unsubscribe, or to report you as a spammer.

- **Give your recipients an easy and obvious way to opt-out or unsubscribe.** If a recipient opts out or unsubscribes, remove them promptly from your mailings. Ideally, this should happen immediately, using an unsubscribe link. However, if not automated, the request must be executed within a specified time period, according to email marketing regulations in most countries. For example, under the CAN-SPAM Act in the United States, a contact unsubscribe request must be completed within ten business days of receipt. In addition, it reflects favorably upon your company when you act in a responsible manner.

Unsubscribe links are typically placed in the footer of the email. The following are common examples of unsubscribe text:

If you would not like to receive future communications from Oracle, please remove yourself by visiting [http://www.oracle.com/unsubscribe.html](http://www.oracle.com/unsubscribe.html).

You are currently subscribed to receive email as john.smith@email.com. You can modify your options or unsubscribe at any time by signing into your account at oracle.com/emailprograms.

If you'd like to unsubscribe from Oracle emails, click here or write to us at Oracle Corporation, 500 Oracle Pkwy, Redwood Shores, CA 94065.
You are receiving this message because you have requested information and updates sent via email. If you no longer wish to receive these emails, please reply to this message with "Unsubscribe" in the subject line or simply click on the following link: Unsubscribe.

If you would rather not receive future e-mail updates from Oracle, please unsubscribe here. We respect your privacy and never share your information.

We sent you this offer because you are a valued subscriber to one of our newsletters. If you no longer wish to have these offers e-mailed to you, click here or reply to this email and place REMOVE in the subject line.

If you want to completely unsubscribe from any e-mail communication from Oracle, please send an e-mail to: unsubscribe@oracle-mail.com with the following in the subject line: REMOVE [EMAIL]

Never fear the Unsubscribe. Remember that if a person unsubscribes from your email list, they probably are not your target customer anyway. Email recipients must be highly interested in your email, otherwise there is no point in marketing to them in the first place.

Provide a valid postal address for your company in each email message. This gives recipients a way to contact you or your company. It is the the law when marketing via email in most countries, and it provides another avenue of communication with the customer. Postal addresses are typically listed in the footer of the email. The following is a common example of how to incorporate your postal address as part of your email:

Oracle Corporation
500 Oracle Pkwy,
Redwood Shores, CA 94065 USA

Oracle Corporation | 500 Oracle Pkwy. | Redwood Shores, CA 94065 | USA

Brand your FROM and ReplyTo lines. The FROM line should always be recognizable and clearly branded, for example, using an address of newsletters@yourcompany.com. If you use a FROM label that a recipient does not recognize, it may prompt them to unsubscribe, even if they are actually interested in your services. The value that appears in the FROM field must always be a valid email address or a merge field email address, such as ${Account.Owner Email Address}, rather than ${Account.Owner}.

Make sure your SUBJECT line accurately reflects the content of your email. It should refer to your brand name, products, or services. Keep the subject line short. Whenever possible, personalize the subject line to your recipient.

For example: VIP Invitation: Oracle Event Series - Email Marketing Outlook 2008.

Add to your address book. Remind subscribers to add your email address to their address book. This reinforces your true email identity to your customers, in addition to providing further deliverability benefits, such as bypassing certain levels of filtering at some mailbox providers.

For example: To ensure delivery to your inbox please add replies@oracle-mail.com to your address book now.

Privacy Policy link. Provide a link to your privacy policy, to explain your policy regarding the use of the customer's email address, including any potential internal and external sharing of it.
Combine images and text in your emails. Be sure to use the ALT tag in HTML for each image. Then, if the recipients’ preferences cause graphics to be stripped from your emails, they are at least left with a text description in place of the image, rather than a placeholder (for example, in Microsoft email clients, the image placeholder appears as a red X).

Personalize messages as much as possible. Tailoring the content of the email to the specific recipient provides the best results. You can personalize the To, From, ReplyTo, Subject, and Body areas of your emails.

Use consistent visual branding in your email messages. This includes factors such as logo, font and color schemes. For example, you may want to match your email look and feel to that of your corporate Web site. Using consistent structure and organization in your emails will also contribute to recognition by your recipients.

Use separators in the text version of your email. Separate the relevant sections of your text-based email with dashed lines, similar to using a horizontal rule in Word or HTML. Separators make it easier to read a text-based email.

Send a subscription confirmation email. Do this immediately after adding an email address to your list. Use this opportunity to reinforce what the customer has signed up for and welcome the subscriber to your service. In this confirmation email, provide links to your privacy policy as it relates to the treatment of email addresses, and include an unsubscribe mechanism. It is also good practice to require that the subscriber click a link in this confirmation email to double opt-in.

For example: You are receiving this because you signed up to receive our newsletter at oracle.com. If you no longer wish to receive email communications from us, you may cancel your subscription by clicking the Unsubscribe link at the bottom of any future email message.

Test thoroughly. Perform test emails before sending out the main campaign, to ensure all links and images work correctly, that the email renders correctly, and that it is delivered to your test inboxes successfully.

Refine your recipient list. Further segment your list, try presenting different offers, using different subject lines, and mailing on different days of the week to determine when you receive the best response. Use A/B testing to small subgroups of recipients before sending to the main group, to see which of your emails had the best response. A/B tests may compare one subject line to another, or may use different images in the body of the email.

Email marketing best practices do not end once the email has been sent. The way you manage the responses to your message has as great an impact to the ongoing deliverability of your email campaigns as the actual content.

Monitor your recipient responses daily. Do this to identify immediate campaign specific problems.

Take a broader view and monitor responses on a monthly or quarterly basis. Do this to help identify trends that may be related to specific messaging streams, recipients or campaigns. Identify what was done differently in high-response campaigns compared to low-response campaigns. Look at things such as the source and composition of your list and the content and creative.
B Basics of Email Campaign Development

Proper planning is the key to a successful email campaign. This appendix describes the many factors that you should keep in mind when planning your campaign — whether you are an expert or a beginner; you can use these general guidelines to keep you on the right track. This appendix includes the following topics:

- About Email Campaign Development on page 51
- Where to Begin on page 51
  - Determining the Goals of Your Campaign on page 52
  - Determining Your Target Market on page 52
  - Determining Your Call to Action on page 52
  - Developing Your Privacy Policy and Anti-Spam Policies on page 53
  - Choosing Your List on page 53
  - Importance of Permission on page 53
  - Deciding on Your Message Format on page 54
  - Determine Your Content on page 54
  - Determining Who Will Manage Your Creative on page 54
  - Deciding How Many Mailings Will Be in Your Campaign? on page 55
  - Implementing Response Tracking on page 55
  - Organizing Internal Resources for Handling Responses on page 55
  - Planning for Unsubscribed and Failed Messages on page 55
  - Developing a Message Testing Plan on page 56

About Email Campaign Development

Opt-In email campaigns are arguably the most powerful tool available to get your message across to your target market. Opt-In Email campaigns are a highly effective, low-cost medium that gets immediate responses. The advantage of using email is that responses are typically generated within 48-72 hours, so the effectiveness of a campaign can be assessed quickly, rather than waiting several months for the results of a direct mail or advertising campaign.

Where to Begin

Opt-In Email campaigns are ideal for a variety of purposes, including:
Increasing sales
Building branding awareness
Up selling
Cross selling
Improving your relationship with your customers

You're probably already familiar with the benefits of opt-in email campaigns, which is why you are ready to begin an email campaign of your own. Regardless of the end-result you desire, there are some guidelines that you should follow when planning your campaign. The following roadmap will keep you on track towards a future of successful email campaigns.

Determining the Goals of Your Campaign

You may know that you want recipients to download your datasheet, but do you have a number in mind? Do you have a sales goal? Do you want a certain number of individuals to sign up for your newsletter? Decide what you feel would make a successful campaign as a benchmark for your efforts. Having solid but realistic goals in mind will make it much easier for you to determine if your campaign was a success.

In many cases, the goals you set may be exceeded. In others, maybe not, but they may uncover new goals for future mailings. For example, you may have initially wanted your recipients to download a whitepaper from your Web site. Instead of clicking on the URL to download the whitepaper, more recipients may have opted to sign up for the newsletter you are offering. As a result of this mailing, you may want to create specialized content in your newsletter that will promote your whitepaper. Or alternately, you may want to revisit the copy you used to describe the whitepaper, or change the name of your whitepaper to make it more enticing.

Determining Your Target Market

Who exactly are you trying to reach? This, along with your call to action, can be one of the most important aspects of your campaign. Think long and hard about the demographic you are trying to reach, because if you start a campaign not knowing this, you will miss a key ingredient for the rest of your planning. Not only will it shape the type of message you send, it will also shape your call to action, the list segments you choose, and ultimately, your campaign’s success.

Determining Your Call to Action

What exactly do you want those who receive your email to do? Should the ultimate action be:

- Buy a product?
- Download a whitepaper?
- Cross-sell or up-sell other products or services?
- Encourage individuals to register on your site?
Encourage individuals to sign up for a new newsletter you are offering?

■ Visit a specific Web page?

You may also merely be trying to build a solid relationship with the individual, for which email is an excellent tool, but is harder to quantify. Determining your call to action will ultimately help you to determine the success of your campaign, so you will want to focus on this early in the planning process.

Developing Your Privacy Policy and Anti-Spam Policies

Recipients will be much more responsive (and happier) if you are very clear about how you got their email address, how you will be using it, and how they can unsubscribe from your email list. Briefly explain your privacy policy within the context of your message, and place a link to your full privacy policy in all communications, right next to the unsubscribe link.

By providing a way for recipients to opt-out of future mailings, you are being a responsible email marketer and will have much happier readers. Make the process as painless and easy as possible. For more on this topic, see Planning for Unsubscribed and Failed Messages on page 55.

Choosing Your List

Mailing to the appropriate individuals is of the utmost importance. If you have an in-house list that you will be mailing to, you are ahead of the game on two counts:

■ You know that your audience will recognize you (since they have already given you permission to send them correspondence from you), and

■ You will avoid the possibility of high costs that come with renting a high-quality opt-in list.

If you do not have an in-house list to mail to, you can contact a list broker who can help you to choose the appropriate lists for your mailing. The list segments that list brokers offer are becoming increasingly specialized, so that you can really drill down to the types of individuals you would like to reach. As a bonus, many will allow you to test your mailing on a portion of their list. You can find out very fast if your offer is a dud, or if the list is a dud. Be aware that you may have to give up the control of mailing to the list yourself, and mail through their designated facility, as most reputable list brokers will not hand a list over to you or your mail house (or outsourcer). This may limit the types of messages you send to your recipients as well, so be sure to get all the facts about their mailing policies before signing on the dotted line.

Last but not least — if you use a list broker, remember to have at least a proof of the creative you would like to send, so that your list request can be approved in a timely manner.

Importance of Permission

Regardless of whether you are renting a list, or using your house list for your mailing, make sure you have the recipients’ permission to mail to them. If you are renting a list, do your very best to learn how the names were acquired and exactly what the recipients asked to receive.
Many organizations define spam (unsolicited commercial email) as a mass mailing, but technically that is not the case. If you send one message to a person who has not asked for information from you, even if their email address is in your database, it will probably be construed as spam. To avoid this kind of trouble, when individuals register on your site, make sure you ask them if they would like to receive correspondence from you in the future. And make sure you rent lists from a reputable list broker who can provide you with the assurance that the names you are getting are actually opt-in.

**Deciding on Your Message Format**

Most email marketers create their message in a variety of formats to appeal to all users on their list. Decide what types of messages you would like to create for your campaign. These could include: HTML, Text, AOL, Wireless, and Rich Media formats.

**Determine Your Content**

Be as creative as possible. Keep the copy tightly focused, and your call to action clear and concise. However, do not forget the housekeeping items. When determining the content you will include in your message, include the following items:

- How you got their name, and how you intend to use it.
- An easy and clear unsubscribe mechanism.
- A link to your privacy policy.
- An email address within your organization to which comments can be sent.

It is always a good idea to personalize the content of your message if possible. For more information on personalizing the content of your message, see Creating Email Content on page 17.

Ultimately, be sure that the message you are sending is relevant to your recipients. Based on the list segments you have chosen, develop the appropriate content. For example, do not send a women's shoe sale announcement to a male segment of your list (that is, unless that segment has specifically asked for this type of information).

**Determining Who Will Manage Your Creative**

Will you keep the creative in-house, or will you contract a designer to do the work for you? If you decide to look outside of your organization, keep in mind that it may take longer to get your creative completed. Also keep in mind that your creative may need to be completed before a list broker will allow you to mail to their list.
Deciding How Many Mailings Will Be in Your Campaign?
Will your campaign consist of a single mailing or will it be a series of messages over a given period of time? For instance, will you send:

- The same message once
- The same message spaced over time with different offers
- A campaign of many different messages all relating to the same call to action

Implementing Response Tracking
Determine what response rates you will want to know for this campaign at the beginning of the planning process, ideally in conjunction with your goal setting and deciding on a call to action.

What information do you need at the end of this campaign to determine if it is a success? What statistics would you like from the campaign:

- Message open rates?
- Click-through rates?
- Unsubscribe rates?
- Bounce rates?
- The number of individuals who forwarded the message to a friend?

Organizing Internal Resources for Handling Responses
In the best-case scenario, your email campaign is a phenomenal success. People are breaking down your door to buy your product, or download your whitepaper. But here is something to ask yourself:

- Are you capable of handling this response?
- Do you have the resources in place to handle the incoming calls or inquiries (or sales) that result from your campaign?

If you are unsure, speak with your Customer Service and Sales departments (or the department that will be handling the responses to your call to action) departments to determine what your organization can handle and ensure you will be able to offer better service to those who respond. If your resources are limited, you may want to throttle or stagger your message delivery so that any responses generated can be handled in a timely manner.

Planning for Unsubscribed and Failed Messages
What is your plan for individuals who want to unsubscribe from your mailings in the future? Will you have an automated process? An email address to which people will send their requests? It may seem like a minor detail, but it is necessary to include as it is now required as part of anti-SPAM legislation in most countries. You should make it as easy as possible for a recipient to be removed from your list.
What about all those bounces that will come back to you? You can be sure that 2-20% of your messages WILL come back to you in the form of a failed message. A failed message will be either a hard bounce or a soft bounce. For more information on how to manage failed messages, see Managing Bounced Emails on page 43. How will you update your database? You should designate a specific process for evaluating and processing bounces. Determine what you will do with hard bounces, such as deleting the contacts from your database, or creating an activity to follow up with the recipient to confirm their contact information.

**Developing a Message Testing Plan**

Make sure your message can be read by a variety of browsers and clients outside of your network.

Many times you may have spelling errors in your message, coding errors in your HTML, or a broken link within a message. If possible, test your message on a variety of platforms and systems such as MS Outlook™, Netscape™, AOL, Hotmail, Yahoo and Gmail. Testing your message will ensure that your recipients receive the message that you intended to send. Those few extra minutes will make the difference in a recipient’s perception of your organization.
This appendix discusses issues that may arise in Email Marketing On Demand, and suggests solutions. It includes the following topic:

- Troubleshooting in Email Marketing On Demand on page 57

## Troubleshooting in Email Marketing On Demand

When you cannot perform a task and receive an error message, use the information in this section to help you diagnose the problem, identify a possible cause, and determine a way to resolve the problem.

If you encounter an error that is not described in this section, or if the solution provided in this section does not solve the problem, contact Siebel CRM On Demand Customer Care.

Table 10 lists troubleshooting issues and suggests solutions.

### Table 10. Troubleshooting Email Marketing On Demand

<table>
<thead>
<tr>
<th>Symptom or Error Message</th>
<th>Diagnostic Steps or Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>When you click the Setup Email button, the following error message appears: You are not authorized to view this page.</td>
<td>Email Marketing On Demand access is controlled by user role privileges in a user’s Siebel CRM On Demand user profile and their corresponding Email Marketing On Demand user profile. The user role has appropriate Siebel CRM On Demand privileges for Email Marketing On Demand, but no corresponding user record has been created within Email Marketing Administration.</td>
<td>Check that a record exists for the user in Email Marketing On Demand. If no record exists, you can create one. Navigate to Admin &gt; Email Marketing &gt; User Administration and locate the user in the Users list. If no record exists for the user, you must add one. See “To add users to Email Marketing On Demand” on page 7.</td>
</tr>
<tr>
<td>The user record has been created in Email Marketing On Demand, but the User ID does not match the Siebel CRM On Demand User Sign In ID.</td>
<td>Check that the Email Marketing On Demand field User ID is identical to the Siebel CRM On Demand field User Sign In ID. See “To edit a user record” on page 8.</td>
<td></td>
</tr>
</tbody>
</table>
Email images do not display in the Email Marketing On Demand HTML Preview screen. Instead, the user sees the image placeholder icon.

Because the Email Marketing On Demand editor is browser based, the user’s individual browser settings can affect how the application accesses and displays content.

The user’s browser settings may be blocking the ActiveX controls required by the editor.

Verify that ActiveX controls are enabled in the browser.

In Internet Explorer, navigate to Tools > Internet Options > Security tab. Under Internet Zone, click Custom Level, scroll to the ActiveX controls and plug-ins section, and enable Automatic prompting for ActiveX controls. Close and restart the browser, then test again.

If Automatic prompting for ActiveX controls is already enabled, the user may have overlooked the security information bar, within the browser, notifying them that the content had been blocked. The Information Bar typically displays beneath the browser toolbar, with the message:

To help protect your security, Internet Explorer has restricted this file from showing active content that could access your computer. Click here for options...

To allow the blocked content, the user can click on the Information Bar and then choose Allow Blocked Content.

Users may be unable to access the image storage location from within the Email Marketing On Demand editor.

From the editor HTML Preview Screen, right-click the image placeholder, then click Properties and note the image location.

If the image location is in the Email Marketing On Demand library, verify that the image still exists.

If the image location is outside the Email Marketing On Demand library, verify that the image location can be accessed. For example, if the image resides in a shared network folder, check that it can be accessed from outside the company firewall.
User has updated their Siebel CRM On Demand user profile Language, but the Email Marketing On Demand editor still displays in English.

**NOTE:** This only applies to the Email Marketing On Demand Editor specific content, menus, toolbars and dialogs, as well as the Email Marketing Administration screens. This setting does not affect standard toolbars and items such as Merge Fields.

The display language in the Email Marketing On Demand interface is determined by the user's browser settings.

The browser may not have the required primary language selected. In Internet Explorer, navigate to Tools > Internet Options > General > Languages, and verify that the required language appears at the top of the list in the Language Preference dialog box.

If the required language is missing from the list, do the following:

- In the Language Preference dialog box, click Add, scroll to locate the required language, click to select the language, then click OK.

If the required language is present in the list, but not at the top, do the following:

- In the Language Preference dialog box, click to select the language, then click Move Up as many times as necessary to move the required language to the top of the list, to make it the primary language.

To apply the change, refresh the browser.

The user has selected a primary language setting in their browser that is not currently supported within Email Marketing On Demand.

You must select a supported language in your browser settings.

The languages currently supported are:

- German
- English-British
- English-American
- Spanish
- French
- Italian
- Portuguese

In Internet Explorer, navigate to Tools > Internet Options > General > Languages, and verify that the primary language (the one at the top of the list in the Language Preference dialog box) is a supported language.

For more information on supported languages, see Supported Platforms and Languages on page 6.
The Campaign Status has been set to *Contact Support*. The user has sent a campaign and the status now reflects this message. The Contact Support error is generated by Siebel CRM On Demand. The user may have reached their 500 MB storage limit within the Marketing library. Verify that the user has not reached their 500 MB storage limit within the Marketing Library.

If close to the size limit, delete any non-essential templates and images, or consider archiving them on another server.

Set the status back to Active and re-schedule the Campaign to launch it again.

**NOTE:** Email Marketing On Demand will not automatically try to resend.

Campaign Recipient statuses or responses are not being updated. After sending a campaign, the recipient status field is not updated.

Responses may be beyond 30 days of the Campaign scheduled date.

Verify the Campaign scheduled date falls within the past 30 days. You can quickly determine the scheduled date for a Campaign via the Email Marketing Administration>Outbound Email Usage page. Updated statuses/responses are not accepted beyond 30 days of the scheduled date.

If this is not the cause, please contact Siebel CRM On Demand Customer Care.

Some Email Marketing On Demand components may not be online.

Please contact Siebel CRM On Demand Customer Care for additional assistance.
### Troubleshooting Email Marketing On Demand

**Symptom or Error Message**

- Campaign does not appear to send.
- After sending a campaign, the Campaign does not appear to go out.

**Diagnostic Steps or Cause**

- This may relate to time zone settings. If the time zone is not set within Email Marketing On Demand, it will assume the time zone of the server.
- Do the following:
  - Check if the same time zone is set in both Siebel CRM On Demand and Email Marketing On Demand
  - Review the Outbound Email Usage data under the Email Marketing Administration screen to see if the email send has been recorded.

**Solution**

- Set the time zones in Siebel CRM On Demand and Email Marketing On Demand. Both Siebel CRM On Demand and Email Marketing On Demand track time zone at the user level. You must set the user time zone in Email Marketing On Demand to correspond to that of the CRMOD user record. For more information, see "Adding a User to Email Marketing On Demand" on page 7.

**Symptom or Error Message**

- After sending a campaign, you cannot tell if the email was opened.

**Diagnostic Steps or Cause**

- The Track Message Open tag may not have been used.
- Verify that the Track Message Open tag was inserted when in the Email Marketing On Demand Editor toolbox.

**Solution**

- To automatically track when a message is opened, use the Email Marketing On Demand Editor toolbar to insert the Track Message Open tag.
- This tag can be inserted anywhere in the email, and is triggered automatically when the recipient opens the email. This information is then updated in the Campaign Recipient record within Oracle’s Siebel CRM On Demand to show a status of Message Opened. HTML is required in order to use the $(trackMsgOpen) tag as it is an <IMG> tag referring to a small 1 x 1 GIF, sent in the body of the HTML.

**NOTE:** This image is not seen by the recipient.

---

**Table 10. Troubleshooting Email Marketing On Demand**

<table>
<thead>
<tr>
<th>Symptom or Error Message</th>
<th>Diagnostic Steps or Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campaign does not appear to send.</td>
<td>This may relate to time zone settings. If the time zone is not set within Email Marketing On Demand, it will assume the time zone of the server. Do the following: Check if the same time zone is set in both Siebel CRM On Demand and Email Marketing On Demand. Review the Outbound Email Usage data under the Email Marketing Administration screen to see if the email send has been recorded.</td>
<td>Set the time zones in Siebel CRM On Demand and Email Marketing On Demand. Both Siebel CRM On Demand and Email Marketing On Demand track time zone at the user level. You must set the user time zone in Email Marketing On Demand to correspond to that of the CRMOD user record. For more information, see “Adding a User to Email Marketing On Demand” on page 7.</td>
</tr>
<tr>
<td>After sending a campaign, you cannot tell if the email was opened.</td>
<td>The Track Message Open tag may not have been used. Verify that the Track Message Open tag was inserted when in the Email Marketing On Demand Editor toolbox.</td>
<td>To automatically track when a message is opened, use the Email Marketing On Demand Editor toolbar to insert the Track Message Open tag. This tag can be inserted anywhere in the email, and is triggered automatically when the recipient opens the email. This information is then updated in the Campaign Recipient record within Oracle’s Siebel CRM On Demand to show a status of Message Opened. HTML is required in order to use the $(trackMsgOpen) tag as it is an &lt;IMG&gt; tag referring to a small 1 x 1 GIF, sent in the body of the HTML. <strong>NOTE:</strong> This image is not seen by the recipient.</td>
</tr>
</tbody>
</table>
Table 10.  Troubleshooting Email Marketing On Demand

<table>
<thead>
<tr>
<th>Symptom or Error Message</th>
<th>Diagnostic Steps or Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| A recipient opened an email that included the Track Message Open tag, but this status is not showing in the Campaign | The Track Message Open tag can be blocked in the following ways:  
- The recipient's email preference options can prevent the display of embedded images.  
- Ports used to make the request for the image may be blocked at the recipient's firewall.  
- The recipient may have set up their email application to read text emails only. | This can only be fixed by the recipient. |
| The Clear Content icon in the HTML editor does not work.  
In the Email Marketing On Demand editor, you click the Clear Content icon to clear the HTML or text content from an email. Then, when you navigate to another view and back again, the content is still there. | This is a known issue within the third party editor used by EMOD. | Select the content you want to remove, right-click and click Cut, then click Save to apply the changes to the email. |
| After you click the HTML preview button, the following message appears:  
The Document is Not Ready – Extreme Document Load Time | This message comes from the Email Marketing On Demand Editor, when you have links and images in your email that the editor cannot resolve in a timely manner.  
This message can appear if templates or images are stored outside the Email Marketing On Demand library, if you have a slower PC or if you are using a very large style sheet. | Click the Wait for Document button and allow the editor to resolve the images or template. If the error persists, verify that all links and image paths are correct. If you are using a style sheet, try reducing the size of the style sheet. |
Index

A
absolute positioning of objects 24
adding conditional content to marketing email 13
adding documents to library 9
adding email templates to library 9
adding images to library 9
adding merge fields to marketing email 13
adding response links to marketing email 13
adding users 7
alignment text 22

B
background color applying to text 23
removing from text 23
bidirectional editing 24
body, designing 13
bold toolbar option 23
browser version 6
bullet toolbar option 22

C
campaign, scheduling 13
color, changing font 23
conditional content, adding to marketing email 13
contact adding individual 16
importing batch 17
copy toolbar and menu option 21
copyright character, inserting 23
creating email templates 9
creating marketing email 13
cut, toolbar and menu option 21

delisting users 7
delivery status, tracking 42
designing marketing email body 13
designing marketing email header 13
documents adding to library 9
deleting from to library 9
viewing in to library 9

dating user information 7
e-mail body, designing 13
e-mail campaign, scheduling 13
e-mail HTML editor 13
e-mail templates adding to library 9
creating 9
deleting from library 9
viewing in library 9

doms
fonts background color 23
color 23
heading size 23
size 23
style 23

H
der header, designing 13
horizontal line, inserting 21
HTML editor 13

I
e images adding to library 9
deleting from library 9
locking in position 24
viewing in library 9
import contacts 16
import recipients 16
indent toolbar option 22
italic toolbar option 23
J
justify, toolbar option 22

L
languages, supported 6
library
adding documents 9
adding email templates 9
adding images 9
deleting documents 9
deleting email templates 9
deleting images 9
viewing documents 9
viewing email templates 9
viewing images 9
viewing usage 11
lock table or image in position 24

M
marketing email
adding conditional content 13
adding merge fields 13
adding response links 13
creating 13
designing body 13
designing header 13
scheduling campaign 13
merge fields, adding to marketing email 13

N
named blocks personalization 31
number, toolbar option 22

O
objects, absolute positioning 24
opened messages, tracking 28, 45

P
paste text, toolbar option 21
paste, toolbar option 21
platforms, supported 6
position objects menu 24
print editor content 21

R
recipient
importing batch 17
recipient, adding 13, 16
registered trademark character, inserting 23
response links, adding to marketing email 13
response status, tracking 42
right to left editing 24

S
scheduling marketing email campaign 13
source, view 22
special characters, inserting 24
style class
assigning to text 23
supported
languages 6
platforms 6

T
tables
locking in position 24
text
aligning 22
direction menu 24
indenting 22
remove formatting 23
tracking delivery status 42
tracking opened messages 28, 45
tracking response status 42
trademark character, inserting 23

U
underline, toolbar option 23
undo toolbar option 21
undo, toolbar option 21
users
adding 7
deleting 7
editing information 7

V
view source button 22
viewing documents in library 9
viewing email templates viewing library 9
viewing images in library 9
viewing library usage 11
viewing outbound email usage 11
viewing outbound email usage, viewing 11

W
WYSIWYG, view as 22